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Important information 

Regulatory information 
This equipment is Class III as defined in EN 60950 (i.e., this equipment is 
designed to operate from Safety Extra Low Voltages and does not generate any 
hazardous voltages). 

As this equipment is part of a fire detection system, input power should be 
supplied from an approved power supply conforming to EN 54-4 or UL/ULC and 
FM3230 standards. 

In order for the installation to conform to EN 54-20, pipes must conform at least 
to EN 61386-1 Class 1131. 

This product has been designed to meet the following requirements: 

• NFPA 72 National Fire Alarm and Signaling Code 
• UL 268 Smoke Detectors for Fire Alarm Signaling Systems 
• UL 268A Smoke Detectors for Duct Applications 
• UL 864 Control Units for Fire Protective Signaling Systems 
• CAN/ULC-S524 Installation of Fire Alarm Systems 
• ULC-S527 Control Units for Fire Alarm Systems 
• CAN/ULC-S529 Smoke Detectors for Fire Alarm Systems 

System reacceptance test after reprogramming (UL/ULC and FM3230): To 
ensure proper system operation, this system must be retested in accordance with  
NFPA 72 after any programming change. Reacceptance testing is also required 
after any addition or deletion of system components, and after any modification, 
repair, or adjustment to system hardware or wiring.  

Limitation of liability 
To the maximum extent permitted by applicable law, in no event will UTCFS be 
liable for any lost profits or business opportunities, loss of use, business 
interruption, loss of data, or any other indirect, special, incidental, or 
consequential damages under any theory of liability, whether based in contract, 
tort, negligence, product liability, or otherwise. Because some jurisdictions do not 
allow the exclusion or limitation of liability for consequential or incidental 
damages the preceding limitation may not apply to you. In any event the total 
liability of UTCFS shall not exceed the purchase price of the product. The 
foregoing limitation will apply to the maximum extent permitted by applicable law, 
regardless of whether UTCFS has been advised of the possibility of such 
damages and regardless of whether any remedy fails of its essential purpose. 

Installation in accordance with this manual, applicable codes, and the instructions 
of the authority having jurisdiction is mandatory. 
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While every precaution has been taken during the preparation of this manual to 
ensure the accuracy of its contents, UTCFS assumes no responsibility for errors 
or omissions. 

Advisory messages 
Advisory messages alert you to conditions or practices that can cause unwanted 
results. The advisory messages used in this document are shown and described 
below. 
 

WARNING: Warning messages advise you of hazards that could result in injury 
or loss of life. They tell you which actions to take or to avoid in order to prevent 
the injury or loss of life. 
 

Caution: Caution messages advise you of possible equipment damage. They tell 
you which actions to take or to avoid in order to prevent the damage. 
 
Note: Note messages advise you of the possible loss of time or effort. They 
describe how to avoid the loss. Notes are also used to point out important 
information that you should read. 

Product Symbols 
 

 

This symbol appears on the main board of the unit and indicates that the 
board contains static sensitive components. 

 

This label is located on the laser chamber at the bottom right of the open 
detector and signifies that the unit is a Class 1 Laser product as specified 
in IEC 60825-1. The unit incorporates a Class 3B embedded laser which 
must not be removed from the detector, as retinal damage may result if 
the laser beam enters the eye. 

 

This symbol indicates the Safety ground studs. These are for grounding 
cable screens, etc., and should not be connected to 0V or signal earth. 
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EN 54-20 and UL compliance 
The installation must be designed using PipeCAD software. After designing the 
installation including pipes, endcaps, and sampling holes, enter the detector type. 
To select the detector type, click Options > Calculation options, and then select 
the detector from the Type drop-down list. 

EN 54-20 installation 
Select Options > Calculate, or click on the calculator icon. The software will 
prompt you to choose from Use set hole sizes, Best flow balance, and Max. 
permissible transit time. Select the appropriate option and click OK. The results 
for each pipe (View > Results) show calculations for each sampling hole on the 
pipe with the nearest to the detector at the top of the screen, and the endcap 
hole at the bottom. 

For EN 54-20 compliance the transport time of the last sampling hole shall be 
checked following all installation and proven to be less than or equal to that 
determined by PipeCAD. 

For the installation to comply with EN 54-20 Classes A, B, and C each sampling 
hole must be no less sensitive than 0.31% obs/m. 

The calculation can be further refined by leaving a working detector in the 
protected area for at least 24 hours at the intended alarm factor for the 
installation (this could be done before or after installation). The detector 
sensitivity can be read from the Sensitivity figure on the histogram screen of the 
Remote Control software supplied with each detector. Click Options > Calculation 
options to open the Hole calculation options dialog box. Enter the sensitivity 
value obtained from the practical test, and then click OK. The new calculated 
value will use the real sensitivity from the practical test. 

The PipeCAD software will determine the classification of any used configuration. 
Commissioning and periodic system tests must involve smoke tests to verify that 
the system performs as expected and enters Fire 1 alarm within the time 
determined by PipeCAD from the farthest hole. The detector sensitivity must also 
be inspected to ensure it has not radically fallen from the installed figure. If it has 
changed for any reason, the new figure must be re-entered into PipeCAD and the 
recalculated hole sensitivities must be confirmed to be within the class limits 
shown above. The settings of a compliant system should be recorded, as it is 
possible by changing certain programmable functions to make the system 
noncompliant. If functions are changed, it is recommended that the system is 
retested if continuing compliance is in any doubt. 

UL installation 
Note: UL certified products may also contain additional approvals, e.g. FM3230. 
Please refer to the product labels.  
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UL 268 fire tests were passed with an installation as follows:  

Total sampling pipe length: 160 ft. (single pipe) 

Number of sampling holes: 10 

Worst-case sampling hole sensitivity as indicated by PipeCAD:  
1.28% obs/ft.* 

Alarm factor: 1 

Fire 1 alarm delay: 0 seconds 

These settings gave satisfactory responses to the test fires in 120 seconds or 
better. For the purposes of UL 268 compliance, these should be regarded as 
worst case values. Layouts should be planned in PipeCAD and the indicated 
worst-case hole sensitivity should be better than 1.28% obs/ft.*. Commissioning 
smoke tests should be performed to ensure that the farthest sampling hole from 
the detector is capable of generating a fire alarm within 120 seconds of receiving 
smoke. 

* The results should be verified at installation by entering the installed detector's 
Fire 1 sensitivity (as indicated in the remote software histogram screen) into the 
PipeCAD “Options/Calculation options/Detector sensitivity” field and recalculating 
the layout results. 

 

 

 



 

LaserSense 25 Aspirating Smoke Detector Installers Handbook 1 

Chapter 1 
Product and component 
descriptions 

Summary 
This chapter provides descriptions of the detector features, specifications, and 
controls and indicators. 

Content 
Introduction   2 
Available software for the detector   2 
Specifications   2 
Indicators   4 
Inside the detector   5 
Removable terminal block connections   6 
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Introduction 
This aspirating detector is a highly sophisticated next generation high sensitivity 
aspirating smoke detection product that provides all the benefits of air sampling 
high sensitivity smoke detection, including very early warning. Designed for easy 
installation and commissioning, the detector incorporates a patented artificial 
intelligence known as ClassiFire, which allows the detector to configure itself to 
optimum sensitivity, alarm thresholds, and minimum nuisance alarms for various 
environments. 

This detector operates by drawing air from a protected space via a supervised 
piping network in relatively small areas. The sampled air is passed through a 
dust separator (filter) to remove dust and dirt before entering the laser detection 
chamber. State-of-the-art electronics are used to analyse the sampled air and 
generate a signal representing the level of smoke present. 

ClassiFire intelligence also monitors the detector chamber and dust separator for 
contamination, continually adjusting the appropriate operating parameters to 
counteract the negative effects of any contamination. Aspirating smoke detectors 
are unique in being able to provide a consistent level of protection in a very wide 
range of environments by continuously making minor adjustments to sensitivity. 

Available software for the detector 
The Remote Control and the SenseNET software packages are available to 
program the detector. 

• Remote Control software: Provided free of charge with every detector, this 
software package enables the user to set up and configure the programmable 
functions of one or more detectors from a computer connected via an RS-232 
serial cable. 

• SenseNET software: SenseNET software is used to configure and manage a 
large network of detectors with a simple, streamlined graphical user interface 
from a computer connected to a detector or command module via an RS-232 
serial cable to RS-485 converter interface. 

Specifications 
Caution: This equipment is only to be used in accordance with these 
specifications. Failure to operate the equipment as specified may cause damage 
to the unit, injury, or property damage. 
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Table 1: Specifications 

Specification Value 

SELV rating EN 60950 Class III 

Supply voltage 21.60 to 26.40 VDC  
PSU Type: conforming to EN 54-4 
Electrical safety complies with BS EN 610190-1 

Size 145 W × 220 H × 90 D mm  
(5.7 W × 8.6 H × 3.5 D in.) 

Weight 1.7 kg (3.75 lbs.) with docking station 

Operating temperature range −10 to +60ºC (EN 54-20) 
32 to 100°F (0 to 38°C) )(UL 268, CAN/ULC-S529, 
FM3230 

Operating humidity range 0 to 90% Noncondensing 
BS EN 61010-1 Pollution degree 1 
BS EN 61010-1 Installation category II 

Sensitivity range 
 (%obs/ft.) 
 (%obs/m) 

 
Min. = 7.62%, Max. = 0.00914% FSD 
Min. = 25%, Max. = 0.03% FSD  

Maximum sensitivity resolution 0.0015% obs/m (0.00046% obs/ft.) 

Detection principle Laser light scattering mass detection 

Particle sensitivity range 0.0003 µm to 10 µm 

Current consumption 250 mA 

Relay contact rating 500 mA at 30 VDC 

Optional relay input card contact rating 1 A at 24 VDC 

Maximum sampling pipe length 50 m (165 ft.) total 

Sampling pipe inlets 1 

Sampling pipe internal diameter 3/4 in. (ID) or 27 mm (OD) 

Alarm levels 4 (Fire (Alarm) 2, Fire (Alarm) 1, Pre-Alarm and Aux) 
1 relay as standard, others available 

Chamber service intervals Greater than 8 years (depending on environment) 

Dust separator (filter) replacement 
intervals 

Greater than 5 years (depending on environment) 

Laser lifetime (MTTF) Greater than 50 years 

Programming PC via RS-232 or RS-485 

Data bus cable RS-485 data cable 

Data bus length 1.2 km (3/4 mile) 

IP rating IP50 
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Indicators 
Figure 1 shows the three indicators on the detector. 

Figure 1: Detector indicators 

 

Alarm

Fault

OK

(1)

(2)

(3)

  

(1) Alarm: Illuminates when the alarm level has been reached and the appropriate time delays 
have expired. 

(2) Fault: Illuminates when the unit has a fault and a fault signal is being sent to the fire alarm 
panel. It also illuminates when the unit is isolated 

(3) OK: Illuminates to show normal operation when there are no faults. The OK lamp will flash 
during the 15-minute FastLearn period when the detector is first learning about its 
environment. 
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Inside the detector 
Figure 2 shows the main interior parts of a detector with the cover off. 

Figure 2: Detector interior view (EN/UL certified models) 

 

 

 

 

 

(1) Removable terminal block connections 

(2) Filter (dust separator) 

(3) RS-232 serial port 

(4) Detector address DIP switch 

(5) Addressable Programmable Interface Card (APIC) or Relay Card port 

(6) Internal cover (UL certified models only) 
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Removable terminal block connections 
Figure 3 shows the terminal block connections that connect the detector to other 
electronic components. 

Figure 3: Detector terminal block connections 

(1)

(2) (3) (4) (5)

 

(1) Fault relay contacts (Open = FAULT) 

(2) Fire (Alarm) relay contacts (Closed  = FIRE) 

(3) APIC addressable bus connections for use in conjunction with interface card 

(4) RS485/SenseNET connections 

(5) Power supply connections 
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Chapter 2 
Installation and 
configuration 
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Introduction 
This topic provides information necessary to install the detector system. 

To install the detector: 
1. Unpack the shipping carton. Ensure that the package contains a CD-ROM, 

three ferrite rings, two cable glands, and the unit. 

2. Determine the optimum location for the detector. 

3. Mount the APIC or Relay Card inside the detector, if required. 

4. Mount the docking station. 

5. Connect the docking station to the sampling pipe network. 

6. Mount the detector to the docking station. 

Installation should only be done by factory-trained technicians. 

Note: Each relay card is supplied with a RF suppression ferrite ring. To ensure 
compliance with all relevant EMC requirements, conductors connected to the 
fault output (included screen wire) should be wound once around a ferrite. 

Installation should be in accordance with applicable installation requirements. 
These include: 

• NFPA-70, National Electrical Code 
• NFPA-72, National Fire Alarm and Signaling Code 
• CSA C22.1 Canadian Electrical Code, Part 1 
• CAN/ULC-S524 Installation of Fire Alarm Systems 
• Any other local, national, or installation requirements or standards.  

WARNING: Electrocution hazard. All connections should be made with the 
power turned off. 

Antistatic precautions 
This system contains static-sensitive components. Always ground yourself with a 
proper wrist strap before handling any circuits. This recommendation must be 
followed when removing the equipment case, and during installing and servicing. 

Caution: When handling any electric components or printed circuit boards, 
antistatic precautions must be followed. Failure to do so may result in component 
damage. 

Electro-static discharge can be reduced by adhering to the following guidelines: 

• Always use conductive or antistatic containers for transportation and storage, 
if returning any item. 

• Wear a wrist strap while handling devices and ensure that a good ground is 
maintained throughout the installation process. 
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• Never subject a static sensitive device to sliding movement over an 
ungrounded surface and avoid any direct contact with the pins or 
connections. 

• Avoid placing sensitive devices onto plastic or vinyl surfaces. 
• Minimise the handling of sensitive devices and printed circuit boards (PCBs). 
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General installation guidelines 
The following is a brief set of guidelines on installing detectors: 

• The detector should normally be mounted at a level where there is easy 
access to the RS-232 serial port for configuration and programming. 

• The exhaust air from the unit must not be impeded in any way. If the unit is 
mounted where the air pressure differs from  the sampling location (for 
example an air duct), then a pipe must be routed from the exhaust port back 
to the same air pressure zone as the sampling holes. 

• Sampling holes should be free from burrs and swarf. 

• All signal cables must be suitable for the application. The specific type of 
cable will normally depend upon the local fire regulations. 

• The unit must not be placed in areas where either the temperature or humidity 
is outside the specified operating range. 

• The unit should not be placed in close proximity to any equipment expected to 
generate high levels of radio frequency signals (such as radio alarms) or units 
generating high levels of electrical energy (such as large electric motors or 
generators). 

Docking station 
The basic principle behind the easy installation of the detector is that all wiring 
and pipework is installed using a docking station. This is a convenient feature 
that allows the detector to be dismounted or replaced without disturbing any 
wiring or installed pipework. 

The docking station inlet (sampling) port and exhaust port is used to interface 
with the pipe network. The inlet port is used for aspirating the pipework network. 
The exhaust port allows the detector exhaust air to be routed back to the 
sampling area, when differing atmospheric pressures require this. (Refer to 
Figure 4.) 
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Figure 4: Docking station 

 

(1) Cable gland 
(2) Earth stud 
(3) Exhaust port 

 (4) Sampling port 
(5) Mounting screw holes 
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Application 
This detector is a smoke detector intended to provide localised incipient fire 
detection. It is suitable for use in a wide range of applications, such as small 
noncompartmentalised rooms, warehouse racking, or pieces of electronic or 
electromechanical equipment where it is desirable to achieve individual incipient 
fire reporting. In compartmentalised rooms, each compartment would normally 
use individual aspirating detectors. 

The detector employs a low-power aspirator (fan) designed to detect incipient 
fires in relatively small areas. The detector is not intended to protect large areas, 
or to sample from areas where there may be any difference in airflow rates or 
pressure differentials. If detection in environments conforming to these 
descriptions is required, other type detectors should be used. 

System design 
Simple designs with short sampling pipes produce the best results. Complex 
sampling pipe runs should be avoided with the detector. The use of  
T-branch pipes is not recommended. Maximum recommended sampling pipe 
length is 50 m (165 ft.) in still air. If the protected area has airflow present, the 
maximum permitted sampling pipe length will be reduced. 

Note: PipeCAD pipe modeling software must be used when designing a pipe 
network and verifying its performance. Refer to the PipeCAD System Design and 
Installation User Guide for complete instructions on how to design and install an 
air sampling pipe network. 

In order for the installation to conform to EN 54-20, pipes must conform at least 
to EN 61386-1 Class 1131. 

Sampling pipes must have capped ends. The end cap should be drilled with a 
hole normally between 4 or 5 mm diameter and free from burrs. Sampling holes 
should normally be 3 to 4 mm diameter or as calculated by PipeCAD, and free 
from burrs. Each pipe run should not have more than 10 holes (including the end 
cap hole). Pipe transit time from the furthest sampling hole from the detector 
must not exceed 120 seconds and an approved type of pipe must be used. It is 
strongly recommended that the smoke transit time from the furthest sampling 
hole be checked during commissioning tests.  

Capillary remote sampling points may be used in place of sampling holes. 

Always locate the sampling points in positions to which smoke may reasonably 
be expected to travel. It is usually better to locate the sampling pipe directly in the 
airflow (for example, across the return air register of an air conditioning unit). 

Note: There is no substitute for carrying out smoke tests prior to installation of 
pipework to indicate suitable sampling point location. 
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No more than one air handling unit may be protected with one detector. In this 
application, ensure that the sampling pipe is raised clear of high velocity air in the 
immediate vicinity of the air intake grill on standoff posts as shown in Figure 5. 

Figure 5: Air handling unit in vicinity of the detector (exhaust shown for clarity) 

 

(1) Incorrect location 
(2) Detector 
(3) Sampling pipe 
(4) Standoff posts 
(5) Correct location 

 (6) Detector 
(7) AHU 
(8) Equipment cabinet 
(9) Direction of smoke 
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Below or above the ceiling installations 
The detector is supplied with a docking station (as shown in Figure 4 on page 
11). This allows the detector to sample from areas which may be at different air 
pressure from the detector location. Typical uses are for air duct sampling and 
allowing the installation of the detector in under-floor or ceiling voids or when 
sampling from pieces of computer related equipment. See Figure 6 and Figure 7. 

Figure 6: Installation of pipework above ceiling with exposed detector (piped exhaust) 

 

(1) Sampling pipe 
(2) Sampling hole 
(3) Detector 

 (4) Exhaust pipe 
(5) False ceiling 
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Figure 7: Installation with detector mounted in ceiling void (no exhaust piping) 

 

(1) Sampling pipe 
(2) Sampling hole 

 (3) Detector  
(4) False ceiling 
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Table 2 below contains a list of procedural guidelines for installation of the  
detector. 

Table 2: Procedural guidelines 

Do Don’t 

Ensure that the power and signal cables are 
correctly connected before powering up by use 
of cable identifiers or electrical continuity 
checks. Incorrect connection could damage the 
detector. 

Ensure that cable of an appropriate approved 
type is used for interconnection. 

Place sampling points so that the detector will 
be able to detect smoke at the earliest 
opportunity. 

Ensure that the detector exhaust is in an area 
with the same atmospheric pressure as the 
sample pipes, either by placing the detector 
physically in the protected area or by leading a 
pipe from the detector exhaust to the protected 
area. 

Ensure that the environment of the protected 
area is within the environmental operating 
parameters of the detector. 

Set the appropriate ClassiFire alarm factor for 
the area to be detected. 

Set the detector address switches correctly 
when used in a network. 

Ensure that the detector is properly grounded. 

Drop the detector. 

Install detectors in damp or exposed areas. 

Remove or connect boards when the detector is 
powered up. 

Connect internal 0 volt terminals to local earth. 

Attempt to re-use dust separator (filter) 
cartridges once removed. 

Attempt to adjust or alter detector settings other 
than via the user-programmable functions. Any 
attempts to adjust the laser potentiometer are 
detectable and will void the warranty on the 
product. 

Place the detector near high power RF sources. 

Place the detector so close to other equipment 
that there is insufficient room to access and 
change the dust separator (filter) or access the 
RS-232 connector. 

Use sampling pipe of less than 27 mm (1 in.) 
outside diameter without a suitable 27 mm  
(1 in.) pipe adapter. It is important that there are 
no leaks where the pipe connects to the 
detector. 

Use excessive force when fitting sampling pipes 
as this may damage the detector. 
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Installation  

Mechanical installation 
The docking station is connected to the installed sampling pipework and fixed to 
the mounting surface using three screws of a type appropriate to the mounting 
surface. Ensure that the sampling and exhaust pipes are securely seated in the 
pipe ports before securing. If using a piped exhaust docking station, be sure that 
the sampling and exhaust pipes are fitted into the relevant ports as shown in 
Figure 4 on page 11. 

Removing the front cover 
To remove the front cover, unfasten the four attachment screws on the front of 
the unit. The cover may then be removed. 

Electrical installation 
The detector is supplied with removable terminal blocks (Refer to Figure 3 on 
page 6.) These may be removed from their sockets by lifting them up at right 
angles to the circuit board. 

Take note of the orientation of each terminal block and its function before 
removing it. It may also be beneficial to mark the connection wires with suitable 
identification labels or colored rings to aid in the connection process. 

Each detector is supplied with three RF suppression ferrite rings. To ensure 
compliance with all relevant EMC requirements, the conductors of each cable 
should be wound once around a ferrite as shown here before entering the 
relevant connector.  

Note: Both power conductors and relay conductors should be on a separate 
ferrite, but different forms of signal conductor (e.g. RS-485) can share the same 
ferrite.  

There should be about 30 mm (1-1/4 in.) of wire between the end of the ferrite 
and the terminal block to give adequate stress relief. To achieve this, it is 
necessary to strip back the cable screen approximately 130 mm (5 in.). The 
screen should be terminated under the cable gland cap (as shown in Figure 8). 
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Figure 8: Looping relay connection wires around a suppression ferrite 

 

 

WARNING: Electrocution hazard. All connections should be made with the 
power turned off. 

Power supply connections 
The power supply cable should be the shielded (screened) type and should be 
routed through the metal cable gland provided, leaving about 35 mm (1-1/4 in.) of 
the cable extending from the bottom of the cable gland. Depending on the type of 
cable used, it may be necessary to increase the diameter of the cable with 
sleeving or insulating tape to ensure that the cable is firmly held when the cable 
gland is fully tightened. 

Note: It is important that you are aware of the orientation of the terminal block 
before removing it. 

To connect the power supply: 
1. Remove the detector front cover and detach the power supply terminal block, 

located at the top left inside the detector. (Refer to Figure 2 on page 5 for a 
photograph of the detector with the front cover removed. Refer to Figure 9 for 
a detailed photograph of the power supply terminals.) 

2. Connect 0 V and +24 VDC to the 0V and 24V screw terminals respectively. 

3. Connect the shielded (screened) wire to the ground stud on the docking 
station. 

4. Connect a second wire from the Earth terminal to the docking station ground 
stud. Figure 4 on page 11 shows the location of the ground stud. 

5. Connect the ground wires to the ground stud. 
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Figure 9: Detector power supply terminals 

 

Signal connections 

To connect the signal wire: 
1. Lead a suitable wire type (RS-485 cable 9841, 120 ohm shielded (screened) 

twisted pair or equivalent) through the second cable gland. 

2. Tighten it into position with approximately 35 mm (1-1/4 in.) of cable from the 
bottom of the cable gland. 

3. Remove either the three-way terminal block next to the power supply socket 
(if connecting the detector to a SenseNET system) or the four-way Bus 
terminal block (if connecting the detector to an alarm panel in conjunction with 
the APIC addressable bus card). Refer to Figure 10 for an illustration of the 
terminals and “Setting the detector address” on page 23 for details on 
addressing. 

Figure 10: APIC address and RS-485/SenseNET terminals 

(1) (2)  

(1) APIC Address terminal  (2) RS-485 / SenseNET terminals 
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For example, in a networked system using screened cable, connect the screen 
wires to the SCN terminal, Bus A wires to the A terminal and Bus B wires to the B 
terminal. 

If the detector is in the middle of a networked chain (with input and output 
connections), it may be more convenient to link the common Bus A, Bus B, and 
screen wires to single A, B, and screen wires for linking to the terminal block. 

Figure 11 shows the power and signal connections to the docking station for 
connection to a single network cable. 

Figure 11: Power and signal connections to the docking station 

 

(1) Power supply shielded wire to ground stud 
(2) Power supply 0V wire 
(3) Power supply +24V wire 
(4) Wire from earth terminal to ground stud 

 (5) RS-485/SenseNET Bus shielded wire 
(6) RS-485/SenseNET Bus A wire 
(7) RS-485/SenseNET Bus B wire 

 

Relay connections 
The detector includes a Fire (Alarm) relay (corresponding to the Fire 1 alarm 
level), which closes on alarm, and a general Fault relay, which opens on any fault 
condition or on power-down (see Figure 12). The relays are of the volt-free type, 
with a maximum current capacity of 500 mA at 30 VDC maximum. Connect the 
screen of the relay cables to the ground stud of the detector. 
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Figure 12: Fault and Fire (Alarm) relay contacts 

(1) (2)  

(1) Fault relay contacts  (2) Fire (Alarm) relay contacts 
 

Interfacing with fire alarm panels 
Because of the flexible nature of the detector and the many possible 
configurations, there are many options for interfacing the detectors to a fire 
panel. The detector provides the following methods of interfacing with fire alarm 
panels: 

• To conventional fire alarm panels using the detector’s Fire (Alarm) and 
Fault relay contacts 

• To addressable fire alarm panels via Addressable Programmable 
Interface Cards (APICs) 

APICs, which can be mounted inside the detector, may simplify installation when 
connecting to addressable signaling line circuits (SLC). The APIC used is 
completely dependent on the SLC protocol, and therefore the make and model of 
the fire alarm panel. 

WARNING: Incompatible APIC panel combinations may result in a non-
operational system which may fail to perform during an event, with resultant loss 
of life and/or property. 

The interface is set to single address mode, the card appears at a single address 
on the SLC and the detector status is read from that address. 
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Connecting a detector to an APIC 
The APIC is fitted to the four mounting studs on the detector PCB using the 
supplied screws as shown Figure 13 below. 

The connections to the fire panel are made using the BUS L1 and H1 (bus 1 
input and output) and the BUS L2 and H2 (bus 1 input and output) terminal 
connectors shown in Figure 10 on page 19. 

The settings that need to be made are on the APIC address DIP switches. Both 
switches (SW1, SW2) must be set to the same address. 

Note: Some protocols may not support all the available alarm levels and fault 
reporting is usually a general fault with no detailed fault information. Please 
consult the specific APIC protocol documentation for more information. 

Figure 13: APIC connections (EN/UL certified models) 

(1)

(2)

(3)

  

 
(1) Mounting studs (4X) 
(2) APIC Interface connection 

 (3) APIC address switch (2X) 
(4) Internal cover (UL certified models only) 

 

 

 

 



 Chapter 2: Installation and configuration 

LaserSense 25 Aspirating Smoke Detector Installers Handbook 23 

Setting the detector address 
In order to identify itself to the PC command module or fire panel, each detector 
needs to have a unique address ranging from 1 to 127. The detector address is 
set on DIP switch SW1, at the bottom left of the opened detector on the main 
circuit board. The switch settings are up for 1 and down for 0, and the detector 
address is set as a 7-bit binary code (switch 8 equates to a value of 128 and so 
is outside the usable address range). Refer to Figure 2 on page 5 for the location 
of the detector DIP switches. 

Figure 14 shows a sample DIP switch setting. 

The address equates to 01100011 in binary, or: 

(1 x 1) + (1 x 2) + (0 x 4) + (0 x 8) + (0x 16) + (1 x 32) + (1 x 64) + (0 x 128) = 99 

The full range of available addresses and their relevant switch settings are 
provided in Table 3 on page 24 for reference. 

Figure 14: Sample DIP switch settings 

 

Address table 
Addresses chosen for detectors do not have to be consecutive or in a given 
order as long as they are all different. Table 3 on page 24 provides the 
address table for detectors. 
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Table 3: Address table 
Address 1 2 3 4 5 6 7 8  65 1 0 0 0 0 0 1 0 

 

1 1 0 0 0 0 0 0 0  66 0 1 0 0 0 0 1 0 
 

2 0 1 0 0 0 0 0 0  67 1 1 0 0 0 0 1 0 
 

3 1 1 0 0 0 0 0 0  68 0 0 1 0 0 0 1 0 
 

4 0 0 1 0 0 0 0 0  69 1 0 1 0 0 0 1 0 
 

5 1 0 1 0 0 0 0 0  70 0 1 1 0 0 0 1 0 
 

6 0 1 1 0 0 0 0 0  71 1 1 1 0 0 0 1 0 
 

7 1 1 1 0 0 0 0 0  72 0 0 0 1 0 0 1 0 
 

8 0 0 0 1 0 0 0 0  73 1 0 0 1 0 0 1 0 
 

9 1 0 0 1 0 0 0 0  74 0 1 0 1 0 0 1 0 
 

10 0 1 0 1 0 0 0 0  75 1 1 0 1 0 0 1 0 
 

11 1 1 0 1 0 0 0 0  76 0 0 1 1 0 0 1 0 
 

12 0 0 1 1 0 0 0 0  77 1 0 1 1 0 0 1 0 
 

13 1 0 1 1 0 0 0 0  78 0 1 1 1 0 0 1 0 
 

14 0 1 1 1 0 0 0 0  79 1 1 1 1 0 0 1 0 
 

15 1 1 1 1 0 0 0 0  80 0 0 0 0 1 0 1 0 
 

16 0 0 0 0 1 0 0 0  81 1 0 0 0 1 0 1 0 
 

17 1 0 0 0 1 0 0 0  82 0 1 0 0 1 0 1 0 
 

18 0 1 0 0 1 0 0 0  83 1 1 0 0 1 0 1 0 
 

19 1 1 0 0 1 0 0 0  84 0 0 1 0 1 0 1 0 
 

20 0 0 1 0 1 0 0 0  85 1 0 1 0 1 0 1 0 
 

21 1 0 1 0 1 0 0 0  86 0 1 1 0 1 0 1 0 
 

22 0 1 1 0 1 0 0 0  87 1 1 1 0 1 0 1 0 
 

23 1 1 1 0 1 0 0 0  88 0 0 0 1 1 0 1 0 
 

24 0 0 0 1 1 0 0 0  89 1 0 0 1 1 0 1 0 
 

25 1 0 0 1 1 0 0 0  90 0 1 0 1 1 0 1 0 
 

26 0 1 0 1 1 0 0 0  91 1 1 0 1 1 0 1 0 
 

27 1 1 0 1 1 0 0 0  92 0 0 1 1 1 0 1 0 
 

28 0 0 1 1 1 0 0 0  93 1 0 1 1 1 0 1 0 
 

29 1 0 1 1 1 0 0 0  94 0 1 1 1 1 0 1 0 
 

30 0 1 1 1 1 0 0 0  95 1 1 1 1 1 0 1 0 
 

31 1 1 1 1 1 0 0 0  96 0 0 0 0 0 1 1 0 
 

32 0 0 0 0 0 1 0 0  97 1 0 0 0 0 1 1 0 
 

33 1 0 0 0 0 1 0 0  98 0 1 0 0 0 1 1 0 
 

34 0 1 0 0 0 1 0 0  99 1 1 0 0 0 1 1 0 
 

35 1 1 0 0 0 1 0 0  100 0 0 1 0 0 1 1 0 
 

36 0 0 1 0 0 1 0 0  101 1 0 1 0 0 1 1 0 
 

37 1 0 1 0 0 1 0 0  102 0 1 1 0 0 1 1 0 
 

38 0 1 1 0 0 1 0 0  103 1 1 1 0 0 1 1 0 
 

39 1 1 1 0 0 1 0 0  104 0 0 0 1 0 1 1 0 
 

40 0 0 0 1 0 1 0 0  105 1 0 0 1 0 1 1 0 
 

41 1 0 0 1 0 1 0 0  106 0 1 0 1 0 1 1 0 
 

42 0 1 0 1 0 1 0 0  107 1 1 0 1 0 1 1 0 
 

43 1 1 0 1 0 1 0 0  108 0 0 1 1 0 1 1 0 
 

44 0 0 1 1 0 1 0 0  109 1 0 1 1 0 1 1 0 
 

45 1 0 1 1 0 1 0 0  110 0 1 1 1 0 1 1 0 
 

46 0 1 1 1 0 1 0 0  111 1 1 1 1 0 1 1 0 
 

47 1 1 1 1 0 1 0 0  112 0 0 0 0 1 1 1 0 
 

48 0 0 0 0 1 1 0 0  113 1 0 0 0 1 1 1 0 
 

49 1 0 0 0 1 1 0 0  114 0 1 0 0 1 1 1 0 
 

50 0 1 0 0 1 1 0 0  115 1 1 0 0 1 1 1 0 
 

51 1 1 0 0 1 1 0 0  116 0 0 1 0 1 1 1 0 
 

52 0 0 1 0 1 1 0 0  117 1 0 1 0 1 1 1 0 
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53 1 0 1 0 1 1 0 0  118 0 1 1 0 1 1 1 0 
 

54 0 1 1 0 1 1 0 0  119 1 1 1 0 1 1 1 0 
 

55 1 1 1 0 1 1 0 0  120 0 0 0 1 1 1 1 0 
 

56 0 0 0 1 1 1 0 0  121 1 0 0 1 1 1 1 0 
 

57 1 0 0 1 1 1 0 0  122 0 1 0 1 1 1 1 0 
 

58 0 1 0 1 1 1 0 0  123 1 1 0 1 1 1 1 0 
 

59 1 1 0 1 1 1 0 0  124 0 0 1 1 1 1 1 0 
 

60 0 0 1 1 1 1 0 0  125 1 0 1 1 1 1 1 0 
 

61 1 0 1 1 1 1 0 0  126 0 1 1 1 1 1 1 0 
 

62 0 1 1 1 1 1 0 0  127 1 1 1 1 1 1 1 0 
 

63 1 1 1 1 1 1 0 0           
 

64 0 0 0 0 0 0 1 0           
 

Connecting a detector to a SenseNET/RS-485 
detector network 
Up to 127 detectors may be linked in a single SenseNET bus, supporting a total 
length of wire between adjacent detectors of up to 1.2 km (3/4 mile). Use a 120 
ohm screened twisted pair such as Belden 9841 24 AWG for all network 
connections. The RS-485 A and B wires should be taken through a ferrite 
(supplied) with a single loop. 

Figure 15 shows an example of two detectors linked into a 127-detector bus with 
a command module and a number of HSSD-2 detectors. Note that whereas the 
HSSD-2 detectors have two input/output buses (1A/1B and 2A/2B), this detector 
has only a single such bus (A/B). Therefore, each bus terminal has an input and 
an output wire, compared with a single wire in each terminal in the HSSD-2 
detectors. 

Figure 15: Connecting a detector to a SenseNET network 

 

(1) Command module 
(2) Detector 1 (HSSD 2)  
(3) Detector 2 (25/100) 

 (4) Detector 3 (25/100) 
(5) Detector 127 (HSSD-2) 
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It is easy to join the input and output wires for each bus and screen connection 
together and to solder or crimp a single wire or connecting ferrule to each wire 
pair so that they are easier to fit into the screw terminals. If this is performed, it is 
recommended that bare wire joints be insulated to prevent possible shorting of 
the data bus, which will cause a drop-out of data on the SenseNET bus. 

In the example shown in Figure 15, there could be a total length of RS-485 cable 
of up to 1.2 km (3/4 mile) between the command module and detector 3, since 
these are all on a single bus. However, detector 3 is a HSSD-2 detector which 
has a second communications bus (RS-485 bus 2) and an RS-485 repeater. This 
allows a further total of 1.2 km (3/4 mile) of cable until the next HSSD-2 in the 
RS-485 loop. 

In the example shown in Figure 15, if detectors 4-126 (not shown) are all this 
type of detector, then the total length of wiring between detectors 3 and 127 
would be limited to 1.2 km (3/4 mile). However, each additional HSSD-2 detector 
wired up using both RS-485 buses would allow an additional 1.2 km (3/4 mile) of 
cabling to be added to the RS-485 loop. 

Final installation 
Once the power and signal connections are made, slide the detector body up into 
the docking station and fasten it into position using the M4 pan head screws 
provided. Slot the power and signal terminal blocks into the relevant sockets on 
the detector PCB (which will only click fully home in the correct orientation). 
Lastly, replace the detector cover using the four M3 pan head screws provided. 
Refer to Figure 16. 

Note: The detector is designed solely for operation with the front cover securely 
fitted using all four mounting screws. 
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Figure 16: Final installation 

 

(1) Docking station attachment screws (2X) 
(2) Cover mounting screws (4X) 

Removing the detector 
Removing the detector is the reverse of the installation process, leaving the 
pipework and wiring connections installed in the docking station (as shown in 
Figure 11 on page 20). See Figure 16 above. 

Configuring the detector after installation 
The detector programmable functions are accessed using a PC (connected to 
the detector) running either the Remote Control software or SenseNET 
programs. 
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Remote Control software  
Provided free of charge with every detector, the Remote Control software 
package enables the user to set up and configure the programmable functions of 
one or more detectors or command module from a computer connected via an 
RS-232 serial cable. Complete instructions on how to install, launch, and use the 
Remote Control software is provided in the Remote Control Software User Guide 
under separate cover. 

SenseNET 
The SenseNET software is available for purchase. SenseNET software can 
configure and manage a large network of detectors with a simple, 
streamlined graphical user interface from a computer connected to a detector 
or command module via an RS-232 serial cable or RS-485 converter interface. 
Complete instructions on how to install, launch and use the SenseNET software 
are provided in the SenseNET Software User Guide under separate cover. 

Note: Since this detector does not include a front panel display or keypad, 
programmable functions cannot be accessed via the unit itself. 

Refer to “Connecting to a PC” on page 29 of this manual for instructions on how 
to connect a PC to a the detector. 

List of programmable functions 
In both the Remote Control and SenseNET programs, the tabbed Functions 
Settings window contains all of the available programmable functions. 

For details about these functions, refer to the appropriate manuals provided 
separately: 

• Remote Control Software User Guide 

• SenseNET Software User Guide 

To change one of the programmable functions, go to the relevant tab, make the 
change, and then click OK to save the changes to the detector’s internal 
firmware. 

The following programmable functions are available: 

• Time and Date 
• Alarm Levels 
• Alarm Delays 
• ClassiFire Override (when optional Input/Relay card is installed) 
• Alarm Factor 
• LDD Enable 
• FastLearn Enable 
• Auto FastLearn Enable 
• ClassiFire 3D 
• Demo Mode 
• Day Start/Night Start 
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• Disable Day/Night Switching 
• Remote Functions (when optional Input/Relay card is installed) 
• Programmed Isolate 
• Latching Alarms 
• Latching Faults 
• Cascading Alarms 
• Device Type (reference only) 
• Firmware Version 
• Run-time Hours 
• Watchdog Count (reference only) 
• Device Text 
• Reference Detector 
• Reference Enable 
• Reference Level 
• Reference Back-off 
• Flow Rate (reference only) 
• Flow High Limit 
• Flow Low Limit 
• Flow Fault Delay 
• Access Code 
• Chart Recording Rate 
• Separator Condition (reference only) 
• Separator Change Date 
• Factory Default 
• Reset 
• Real Time ClassiFire Viewer Histograms (reference only) 
• Chart Recording 

Connecting to a PC 
To connect a single stand-alone detector to a PC, connect the PC‘s serial port 
directly to the detector’s 9-way RS-232 port. Connections for this cable are 
shown in Figure 17. If required, you use a USB to serial RS-232 adapter cable to 
connect to the PC USB port. 
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Figure 17: RS-232 cable connections 

 

(1) 9 pin female D connector 
(2) 9 pin female D connector 
 

Figure 18 shows the RS-232 cable connection from the detector to a PC. 

Figure 18: Detector serial port connection for a PC 

 

 

 

 

 
 

(1) Serial port connection (to PC) 

(2) Gender changer required (UL certified  models only) 
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Event log 
The Event Log is a record of detector events such as faults, alarms and function 
changes. It is stored inside an operating detector and is updated whenever an 
event occurs. The event log is nonvolatile, which means that it is retained when 
the detector is turned off. The last 200 detector events may be stored. 

An event is defined as: 

• A change to any programmed function 

• A signal received from an external controller such as the remote software, 
APIC, or SenseNET 

• A detector output level meeting or exceeding the Pre-Alarm, Aux, Fire 1, or 
Fire 2 alarm thresholds 

• A start of day or night operation 

• Demonstration Mode start 

• FastLearn start or stop 

• Power on or off 

Events can either be viewed on a PC screen or downloaded to disk by running 
the Remote Control program. 

When the detector event log is full (200 events have been logged) and a new 
event occurs, the oldest event in the log is deleted (first-in, first-out). 

To download the event log, connect a PC to the detector serial port and run the 
Remote Control software or SenseNET programs. For details, see the Remote 
Control Software User Guide or the SenseNET Software User Guide. 
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Chapter 3 
Commissioning 

Summary 
This chapter provides information to commission the detection system. 
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Introduction 
This chapter covers the commissioning procedures for the detector. 
Commissioning strategy initially depends upon the environment in which the 
detector is installed. For instance, the test for a computer room (in a relatively 
clean environment) would be very different from, say, a flour mill, with a high 
level of airborne particulate content. 

A widely accepted standard for computer rooms or EDP areas is British Standard 
BS6266, equipment overheating at a stage well before combustion. To perform 
the test electrically overload a 1‑metre length of PVC insulated wire of 10/0.1mm 
gauge for one minute using an appropriate power supply. The detector has two 
minutes from the end of the wire burn to give an alarm indication. 

For areas with higher levels of background particulate matter testing 
methodology would be similar to that of standard point detectors. 

Commissioning should only be done by trained technicians in accordance with 
applicable standards.  

Commissioning checklist 
The following brief checklist allows quick setup of the detector. This procedure 
will be adequate for most standard installations. 

To commission the detector: 
1. Before powering up the detector, visually check all cabling to ensure correct 

connection. If wire identification is not immediately clear (e.g., by use of 
different colored wires or wire identification sleeves), an electrical check 
should be made. 

Caution: Ensure that all wiring connections are checked prior to powering up 
the detector. Incorrect wiring of the detector will cause permanent damage to 
the detector. 

2. Connect the detector to a PC and set the detector address on the DIP 
switches and APIC board (if applicable). Refer to “Interfacing with fire alarm 
panels” on page 21 and “Setting the detector address” on page 23 for more 
information. 

3. Power up the detector. 

4. Ensure that all detectors in the network area are clear of troubles and alarms 
(if applicable). 

5. Launch either the Remote Control software or SenseNET software on the 
computer, enter the access code, and select the Function Settings window. 

6. Verify that the time and date are correct on the Time and Date tab. 
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7. Set an appropriate alarm factor, as shown in Table 4 below, for the protected 
environment on the Alarm Levels and Delays tab. The detector will 
automatically perform a FastLearn for the new alarm factor (which takes 
approximately 15 minutes). The OK indicator on the front panel will begin to 
flash. If using Day/Night switching, check that Day Start and Night Start 
settings reflect site operations. 

8. While the detector is still in FastLearn mode, place a checkmark next to the 
Demo Mode command at the bottom of the Alarm Levels and Delays screen. 
The detector will enter demo mode (where it estimates its final sensitivity) 
immediately after the FastLearn cycle has finished. 

Note: Checking the Demo Mode box only puts the detector into demo mode 
while the detector is performing a FastLearn. It has no effect at any other 
time. 

9. Verify that the FastLearn has concluded (the OK indicator has stopped 
flashing). With the detector in demo mode, perform any necessary smoke 
tests, ensuring that the detector reacts appropriately, and let the smoke fully 
dissipate. 

10. Perform another FastLearn, this time NOT putting the detector into demo 
mode. Do this by placing a checkmark next to the FastLearn Enable 
command in the Alarm Levels and Delays screen. The OK indicator on the 
front panel will begin to flash. 

11. The detector will generate no alarms during the 15 minute FastLearn period 
and, after this, the detector will operate at a reduced sensitivity for 24 hours 
while ClassiFire learns and acclimates to the protected environment and sets 
up appropriate day and night sensitivity settings. 

12. If desired, exit the Remote Control or SenseNET software, power down the 
PC and remove it from the detector serial port. 

Table 4: Suggested settings for ClassiFire alarms 

Alarm 
factor 

Sensitivity Probability of nuisance 
alarm 

Suggested protected area 

0 Extremely High Once per year Semiconductor manufacturing clean room 

1 High Once per 5 years Computer room 

2 High Once per 10 years Non-smoking office 

3 High Once per 50 years Clean factory 

4 Medium Once per 1,000 years Warehouse 

5 Medium Once per 5,000 years Warehouse with diesel trucks operating 

6 Medium Once per 10,000 years Warehouse with diesel trucks operating 

7 Low Once per 20,000 years Warehouse with diesel trucks operating 

8 Low Once per 100,000 years Warehouse with diesel trucks operating 
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Precommissioning preparation 
Commissioning should be performed after all construction has been completed 
and cleaned of any lingering post-construction dirt. If ambient monitoring 
conditions are recorded before the installation is cleaned up, they may not 
accurately reflect actual normal operating conditions that need to be used as 
reference data for follow-up maintenance procedures and tests. 

Acclimation period 
The detector will operate at a reduced sensitivity for 24 hours. ClassiFire will set 
up the appropriate day and night sensitivity settings. All air handling units, 
thermostats and other systems that can have an effect on the operating 
environment should be turned on to simulate normal operating conditions as 
closely as possible. After approximately one week of monitoring time (depending 
on chart log recording rate), download the detector event log to a PC from the 
RS232 port using a serial cable. 

Transport time verification 
The maximum transport time verification test is the measure of the amount of 
time it takes for the detector to respond to smoke that enters the pipe at the 
sampling point furthest from the Detector. The results of this test and the 
calculated maximum transport time from PipeCAD must be recorded on the 
checksheet. Measured transport time less than the calculated time is acceptable. 

To measure the maximum transport time of the system: 
1. Determine the furthest sampling point from the detector. 

2. Allow test smoke to enter the pipe at the furthest sampling point. 

3. Record the amount of time for the detector to respond. This is the actual 
maximum transport time. 

ASD System Performance Tests 
Note: It is recommended to follow local codes of practice for approved tests for 
this type of installation. 

Caution: Oil-based canisters that are used to test point detectors are not suitable 
for testing aspirating systems, as the particulate is heavy and tends to drop out in 
the pipe, never actually reaching the detector. Also, the oily residue that is left 
behind may affect the functionality of the detector. 
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Chapter 4 
Troubleshooting 

Summary 
This chapter provides information to troubleshoot the detection system. 

Content 
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Troubleshooting the detector 
This chapter provides some possible solutions if a problem should occur with 
your detector.  

Note: Consult either the Remote Control Software User Guide or SenseNET 
Software User Guide for more information about the solutions or corrective 
actions discussed here. 

Table 5: Troubleshooting guide 

Problem Solution/Corrective Action 

Nuisance alarms 
occur too often 

Check that the ClassiFire alarm factor setting is appropriate for the normal 
working environment of the protected area. 

Check that the detector is not in demo mode. This can be ascertained by 
viewing the event log and checking that the entry demo mode has a higher 
log entry number than the most recent FastLearn start and FastLearn end 
entries. Note: Remember that the log entries are in reverse order, with the 
most recent entries appearing first. If the log shows that demo mode was 
invoked during the last FastLearn period, start a new FastLearn and allow 
it to complete its 24-hour cycle. 

From the event log, check that 24 hours have elapsed since the last 
FastLearn end entry. 

Check that day-night switchover times are appropriately set to reflect active 
and nonactive periods. 

Elevated smoke 
levels do not 
generate alarms 

Check that detector is not isolated or in FastLearn (if Isolated, the Fault 
light will be lit; if in FastLearn, the OK light will flash). 

Check that the detector sampling points are in the smoke stream. 

Check that sampling pipes are firmly and cleanly seated in their ports and 
undamaged. 

Check that the correct ClassiFire alarm setting has been set. 

Check that the detector has either had a 24-hour learning period or that it 
has been placed in demo mode. 

Low mean output Check that the dust separator (filter) cartridge does not require changing 
(refer to “Replacing the dust separator cartridge” on page 44 for details) 
and that the air plenum chamber is clean. The chamber may become 
clogged when, for example, heavy building activity has occurred near the 
sampling pipes. If so, the chamber may require factory service. The 
detector is not designed to handle large quantities of coarse debris and 
dust. 

Detector sensitivity 
varies over time 

There are many reasons why particle densities may vary, and the 
ClassiFire system is designed to automatically compensate for this in order 
to reduce the likelihood of nuisance alarms due to normal variations in 
background smoke density. Within limits set by the ClassiFire alarm factor, 
this is a normal part of the detector‘s operation. 
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Problem Solution/Corrective Action 

Flow fault errors These occur when the airflow rate into the detector exceeds the 
preprogrammed parameters. As the detector “learns” the flow setup from 
the initial installation, this usually means that there has been some change 
in conditions. If the detector input is sampled from one area and the 
exhaust is in another area with different pressure (e.g., the detector is in a 
roof space and sampling from an enclosed room), this may lead to flow 
faults. In this case, it would be necessary to lead a pipe from the exhaust 
to the protected area to ensure nominal flow. 

Low Flow error 
message 

Check that the pipe is not blocked. 

If the pipe is unused, check that the flow sensor for this pipe has been 
disabled. 

Check that the low flow fault threshold is not set too high. 

In the case of intermittent fault indications, try increasing the flow fault 
delay time. 

High Flow error 
message 

Check that the pipe is seated in the inlet and is not broken or cracked. 

Check that installed pipework is fitted with endcaps. PipeCAD pipe 
modeling software prompts for the use of appropriate endcaps. Open bore 
pipes are not recommended. 

Check that the high flow fault threshold is not set too low. 

In the case of intermittent fault indications, try increasing the flow fault 
delay time. 
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Chapter 5 
Maintenance 

Summary 
This chapter provides scheduled and unscheduled maintenance procedures. 
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Introduction 
This chapter contains maintenance instructions for the detector system. These 
procedures should be performed on a scheduled basis. In the event that system 
problems are found during routine maintenance, refer to Chapter 4 
“Troubleshooting” on page 37. Failure to properly maintain the system may affect 
the functioning of the system. 

Scheduled maintenance 
The scheduled maintenance of the system should be performed at an 
established interval. The interval between performance of maintenance 
procedures should not exceed any imposed regulations. (See NFPA 72 or other 
local requirements). 

Local standards and specification requirements must be adhered to. A typical 
maintenance plan is listed in Table 6 below. 

Notes 
It is prudent to disconnect or isolate the detector from the fire panel during 
maintenance to prevent unintentional alarm activations. 
The detector should be powered down during internal cleaning (use an air duster 
can or dry air gun). 

Table 6: Maintenance plan 

Step Procedure 

1 Check detector, wiring and pipework for damage 

2 Check original design is still valid, e.g. changes due to building upgrades 

3 Check detector for contamination and clean if necessary 

4 Check maintenance logs for issues and rectify as appropriate 

5 Check transport times against original records: significant increases or decreases in 
transport times may imply damaged pipes or sampling holes that need clearing 

6 Isolate detector from fire panel if required 

7 Smoke test to check detector operation and Alarm relay connection 

8 Simulate a fault to check the Fault relay and connection 

9 Complete and file maintenance records 

10 Reconnect detector to fire panel if required 
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Maintenance procedures 
The following paragraphs outline general scheduled maintenance procedures to 
be performed on an “as necessary” basis. 

Caution: Risk of equipment damage. Always turn the power off before servicing 
the detector. 

Visual check 
The visual check must be performed every six months. This check is to ensure 
pipe network integrity. 

To perform the visual check, observe the entire piping network and check for 
abnormalities in the pipes, including any breaks, blockages, crimps, etc. 

ASD System Performance Tests 
Note: It is recommended to follow local codes of practice for approved tests for 
this type of installation. 

Transport time verification test 
The maximum transport time of the pipe network must be measured and 
compared to the recorded transport time at commissioning. (Refer to “Transport 
time verification” on page 36 of this manual for test details.) The transport time 
verification test must be done at commissioning and every year thereafter. 

Detector sensitivity test 
The detector sensitivity test must be performed within one year of installation and 
every alternate year thereafter. 

Example: 

• Year-one check 

• Year-three check 

• If years one and three are OK, go to five-year interval. 

The detector employs a self-monitoring, automatically-adjusting calibration for the 
system. The inspection only requires a periodic visual inspection for a detector 
fault indication and performing the detector sensitivity test function. 

If the self-monitoring feature of the system senses that the operation of the 
detector head is outside its normal range, a trouble condition will be generated. 
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Cleaning the detector 
The exterior of the detector should be cleaned as necessary. Clean the detector 
with a damp (not wet) cloth. Do not use solvents as these may damage the front 
panel label. 

Caution: Do not use solvents to clean the detector. Use of solvents may cause 
damage to the detector. 

Replacing the dust separator cartridge 
The only part that may require field replacement during servicing is the dust 
separator (filter) cartridge. 

After replacing the filter, the detector must be put into FastLearn mode to reset 
the filter condition reading. 

As dust contained in the dust separators may expose maintenance personnel to 
a “Nuisance Dust” hazard as defined by the Control of Substances Hazardous to 
Health (COSHH), it is strongly recommended that suitable masks and protective 
clothing be worn when changing filters.  

Note: Used dust separator cartridges are not intended for reuse and should be 
discarded. 

To replace the cartridge: 
1. Remove the four attachment screws which fasten the unit’s front cover. 

2. With the front cover removed, grasp the filter firmly and pull the filter out 
(directly towards you). 

3. Properly dispose of the used cartridge. 

4. Insert the replacement filter cartridge such that the orientation of the Direction 
of flow arrow printed on the cartridge corresponds to the arrow on the 
“Direction of flow” label beside the filter slot. 

5. Slide the cartridge all the way into place. 

6. Replace the detector cover and screws and initiate a FastLearn routine. 
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Figure 19: Location of dust separator cartridge 

 

(1) Dust separator (filter) cartridge 
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Glossary 

 
°C Degrees centigrade 

°F Degrees Fahrenheit 

A Ampere 

AC Alternating current 

ADA Americans with Disabilities Act 

AH Ampere hour 

AHJ Authority having jurisdiction 

ARC Automatic release circuit 

AWG American wire gauge 

APIC Addressable protocol interface card 

CSFM California State Fire Marshal 

DACT Digital alarm comm. transmitter 

DC Direct current 

DET Detector 

EOLD End of line device 

EOLR End of line resistor 

FSD Full scale deflection 
 

Full scale deflection 

FM Factory Mutual 

ft. Feet 

HSSD High sensitivity smoke detector 

Hz Hertz (frequency) 

in. Inches 

LCD Liquid crystal display 

LED Light emitting diode 

MEA Materials and Equipment Acceptance 
Division of the City of New York 

NAC Notification appliance circuit 

N.C. Normally closed 

NEC National Electrical Code 

NFPA National Fire Protection Association 

N.O. Normally open 
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NYC New York City 

PCB Printed circuit board 

pF Pico farads 

P/N Part number 

PSU Power supply unit 

RAM Random access memory 

SLC Signaling line circuit 

TB Terminal block 

UL/ULI Underwriters Laboratories, Inc. 

V Volts 

VAC Volts AC 

VDC Volts DC 

VRMS Volts root mean square 
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